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PREFACE 

 

Ibn Haldun University, which aims to be a research university, seeks to be a center of 

excellence in teaching and research. This guideline has been prepared per the 

university's founding principle; to achieve this, every thesis or project accepted at the 

graduate level must be submitted per the guideline. Therefore, the primary purpose of 

the guidelines is to guarantee that every thesis and project completed at Ibn Haldun 

University's institutes have the same high standards. 

 

This guide is the primary source for writing all theses and projects completed in Ibn 

Haldun University graduate programs. Discipline-specific rules not specified in this 

guide will be applied additionally. 

 

In parallel with the university's development, updates will be made in this guide when 

necessary. 
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CHAPTER I 

 

GENERAL PRINCIPLES 

 

• Theses and projects must be written electronically using appropriate computer-

based software (e.g., MS Word). 

• The Graduate School Directorates deliver hard and electronic copies of the theses 

to the Ibn Haldun University Library Department and copies of the projects to their 

advisors. The graduate school secretariats can provide information about the 

requirements of this process. 

• It is the student's responsibility to complete the electronic preparation of their thesis 

and project; therefore, students should carefully read and apply this manual's contents. 

• Students should note that when preparing their thesis or project, they should be 

guided only by these guidelines (not by a previously completed thesis or project). 

• For points not explicitly stated or not included in this guide, students should consult 

the Graduate School to which they are affiliated and obtain written approval and 

clarification before continuing their studies. 

 

1.1. Restriction Period in Public Access 

 

For various reasons (potentially patentable information, publication of the thesis as a 

book, etc.), the author of a thesis may request a period of restriction during which the 

work will not be accessible to outside readers. According to the Directive on 

Collecting, Editing, and Making Available Graduate Theses in Electronic Form: 

 

For theses that use new techniques, materials, and methods, that have not yet turned into articles 

or are not protected by methods such as patents, and that contain information and findings that 

may create unfair profit opportunities for third parties or institutions if shared online, the thesis 

may be prevented from being made available for a period not exceeding six months upon the 

recommendation of the thesis advisor and the approval of the head of the department, with the 

reasoned decision of the administrative board of the institute or faculty. 
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Again, according to the same directive: 

 

If a patent application is made for a graduate thesis or the patenting process is ongoing, upon 

the recommendation of the thesis advisor and the approval of the head of the department, the 

institute or faculty administrative board may decide to postpone access to the thesis for two 

years. 

 

After the author's application, the period begins with the decision of the Institute's 

Administrative Board. At the end of this period, the restriction is lifted. 

 

You can access the Directive of the Council of Higher Education (YÖK) National 

Thesis Center on Collecting, Editing, and Accessing Graduate Theses in Electronic 

Environment from the link below:  

https://tez.yok.gov.tr/UlusalTezMerkezi/tezTeslimKilavuz.jsp  

 

1.2.  Plagiarism 

 

Plagiarism is one of the most severe academic crimes and an immoral act. For this 

reason, sources that will be used in any way in the scholarly work (abstract, 

explanation, direct quotation, indirect expression, etc.) must be appropriately 

referenced. In addition, each thesis or project author must sign the “Academic Honesty 

Statement” stating that all parts of the work have been prepared following academic 

and ethical attitudes, with correct citations and references, and submit it to the 

Graduate School to which they are affiliated in the bound thesis after the process after 

the thesis defense is completed. “Academic Honesty Statement” for projects signed 

and attached to the relevant place on the printed copy of the project. For the sample 

“Academic Honesty Statement,” see Appendix G for more information. 

 

1.3. Thesis Writing Language 

 

The thesis or project must be written in the program's language of instruction. 

However, for theses written in English and other languages in departments where the 

medium of instruction is Turkish, a broad Turkish abstract of not less than ¼ of the 

thesis must be given. According to the decision of the Council of Higher Education: 

 

https://tez.yok.gov.tr/UlusalTezMerkezi/tezTeslimKilavuz.jsp
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The Higher Education Executive Board decided on 09.03.2022 to allow theses to be written in 

another language provided that a broad Turkish summary not less than ¼ of the thesis is given 

if the student's request, the reasoned opinion of the advisor, the decision of the Department 

Board, and the approval of the relevant Graduate School Administrative Board in graduate 

programs in which the language of instruction is Turkish are.  
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CHAPTER II 

 

STYLE AND APPEARANCE 

 

When presented properly, the scientific value of the information provided in a thesis 

or project reaches a level of excellence. Ibn Haldun University theses or projects must 

meet all the specifications, from using the right quality paper to proper printing. 

 

2.1. Paper 

 

All pages of the thesis or project must be printed on one side on good-quality white 

paper (at least 75 grams and 297 mm x 210 mm in size, A4 paper). 

 

  

 

 

How to do it? 

 

To select the A4 page size, 

simply double-click on the 

ruler at the top of the page, 

go to the page layout 

screen, choose the "Paper" 

option, and then select A4 

from the paper size section. 
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2.2. Margins 

 

The margins on the page should be 4 cm on the left (binding side) and 2,5 cm on the 

other three sides. All margins must be left blank. There should be no headings, 

footnotes, text, etc. in the margins. 

 

 

 

2.3. Font Type 

 

Times New Roman font and 12-point font size are used in thesis or project writing. 

The font and font size must be consistent throughout the thesis or project. Exceptions 

where the font size may differ from the rest of the text are chapter headings, section 

headings, footnotes, endnotes, block quotations, tables, and charts. Authors may use 

bold type, symbols, and italics for particular emphasis or to indicate unfamiliar words, 

provided that such usage is not excessive within the thesis text. 

 

The thesis or project must be printed on high-quality laser printers. All printing must 

always be done in black ink. 

How to do it?? 

 

To perform this 

action, double-click 

on the ruler at the 

top of the page and 

enter the specified 

cm values in the 

margins section. 
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2.4. Line Spacing 

 

The spacing should be 1.5 lines, and the spacing nk value should be 0. Tables, block 

quotations, footnotes, endnotes, references, and table/figure captions should be single-

spaced. 

 

One blank line is left between paragraphs. Do not indent at the beginning of a 

paragraph. 

 

 

 

 

 

2.5. Footnotes 

 

Information that expands, strengthens, or supplements the content (content footnote) 

may be used in theses or projects. Footnote numbers are placed immediately after the 

citation. If the citation is a paragraph, the footnote number is written above the last 

word of the paragraph; if the citation is a concept or a name, it is written immediately 

above the idea or name. The footnote number in the text should be visible as 1 above 

the line alignment. No punctuation mark should be placed after the number. There 

should be one space between the footnote line and the footnote number and half a space 

between the footnote number and the first line of the footnote. Footnotes should be 

separated from the text by a thin horizontal line. 

How to do it? 

 

You can set the line 

spacing to 1.5 cm 

from the Paragraph 

section in the Home 

tab. 
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2.6. Duplication 

 

The printed copy of the work is considered the “original” copy. For consistency of 

print quality (high-resolution pages always printed in dark color, continuity in 

printing), authors must reproduce their thesis or project using the original copy each 

time. If substandard or poor-quality reproduction is detected, the Graduate School or 

the Library may ask the authors to reprint their thesis or project according to the 

specified standards. 

 

Two printed copies of master's or doctoral theses must be submitted to the Graduate 

School, one to the library and one to the advisor. The number of copies can be higher, 

provided all printing conditions are met.  

 

Two original copies of the project, signed by two project advisors (including the 

signed approval page and the signed academic integrity declaration), must be 

submitted to the Graduate School in person. 

 

How to do it? 

 

Insert Footnote" 

button in the 

References section. 

After that, you should 

make the necessary 

formatting 

adjustments. 
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2.7. Corrections 

 

No manual corrections (ink corrections, overwriting, correction fluid, correction tape, 

pasting, insertion between lines or letters, etc.) are acceptable after the thesis or project 

has been bound/printed. Corrections can only be made on the electronic version before 

it is copied for reprinting. 

 

2.8. Page Layout 

 

All content (text, tables, figures, etc.) should be justified on both sides after adjusting 

the margins rather than on the border of the paper. The content will appear centered 

on the page after the thesis or project is bound/printed. 

 

2.9. Word and Text Breaks 

 

If hyphenation is to be used, words must be split at the end of the line. Words cannot 

be separated when moving from one page to another. A standard Turkish dictionary is 

used to determine the correct word division. At least two lines of a paragraph should 

appear together at the beginning and end of each page. Headings and subheadings 

should follow at least two lines of a paragraph. 

 

2.10. Page Numbering 

 

All page numbers should appear in the same position at the bottom right corner. All 

page numbers should be written in 12-point Times New Roman font in the font format 

used in the text. The page number should be written 0.75 cm from the page edge in the 

footer. 

 

The following page numbering rules should be used: 

 

• Cover pages (outer and inner cover), acknowledgment pages, and academic honesty 

attestation should not be paginated. These pages do not appear in order but are counted 

as i, ii, iii. 
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• Small Roman numerals should be used for the introductory pages (pages between 

the ÖZ and CHAPTER I) (i, ii, iii, iv, etc.). Page numbers appear as “iv” on the ÖZ 

page and continue in sequence until the first page of the text (CHAPTER I). 

• Arabic numerals starting with “1” are used on the first page of the text (CHAPTER 

I) and so on through the rest of the thesis or project. All pages should be numbered 

consecutively, including pages with illustrations, tables, figures, divisions, and 

photographs. Documents other than the main text and references should be classified 

under “APPENDICES.” 
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How to do it? 

 

To insert a page number, double-click 

on the bottom right corner of the page 

to open the footer. In the Design tab, 

click on the page number button, 

scroll to the end of the page, and 

select the third number. 

 

The top header and bottom footer, 

visible in the top right corner, are set 

to 0.75 cm. The text font is formatted 

to 12-point Times New Roman (TNR) 

with a line spacing of 1.5. 
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2.11. Multiple Volumes 

 

Theses thicker than 5 cm when bound should be divided into two or more volumes. 

Each volume should be numbered with Roman numerals. Each volume should have a 

How to do it? 

 

For this formatting, click on 

"Format Page Numbers"; for the 

number format, select "i, ii, iii" for 

the front matter and "1, 2, 3" for 

Chapter 1. Check the "Start at" 

box. 

 

To arrange the page numbers in 

this way, first: Before Chapter 1, 

go to the Page Layout tab > 

Breaks > Next Page (Section 

Break). 
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title page, which should give the same information except for the designations Volume 

I, Volume II, etc. Volume I, Volume II, etc., will be written just below the thesis title. 

The Roman and Arabic numerals used in Volume I, indicating the introductory pages, 

should continue in the other volumes. Like the title page of Volume I, the title page of 

Volume II is counted among the introductory pages but does not carry numbers. If “iv” 

is the last Roman numeral used in Volume I, the title page of Volume II counts as page 

“v,” followed by the introductory pages “vi,” “vii,” etc. Each volume should contain a 

complete “Table of Contents”. 

 

2.12. Binding 

 

Theses or projects have a color code for archiving, classification, and accessibility. 

Accordingly, all master's theses must be bound in black, all doctoral theses in navy 

blue, and all graduation projects in American binding on white cardboard paper. 

 

For sample project outer cover, thesis outer cover, project inner cover, thesis inner 

cover, project and thesis spine, see Appendix A, Appendix B, Appendix C, Appendix 

D, Appendix E, Appendix F, Appendix O, Appendix P, and Appendix S respectively. 

Please see Appendix Q for thesis binding printing and Appendix R for project printing.
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CHAPTER III 

 

TEXT FEATURES 

 

Each thesis or project text should include an introduction, main text, and references. 

The following is a list of the sections that may be included in the text of each thesis or 

project. The list of sections that must be included in the text of each thesis or project 

is given in the following order. Required sections are marked with an asterisk. 

 

 COVER PAGES* 

  Outer Cover* 

  Inner Cover* 

 INTRODUCTION PAGES* 

  Approval Page* 

  Academic Honesty Attestation * 

  Öz* 

  Abstract * 

  Dedication 

  Acknowledgment or Preface 

  Table of Contents* 

  List of Tables 

  List of Figures and Illustrations 

  List of Symbols and Abbreviations 

 MAIN TEXT* 

  Section Headings* 

  Main Text* 

 REFERENCES* 

  References* 

 APPENDIX 

  APPENDIX A Title 

 CURRICULUM VITAE* 



 

  14  

3.1. Cover Pages 

 

3.1.1. Outer Cover 

 

The thesis or project outer covers are made according to Appendix B, Appendix C, 

and Appendix Ç samples. Institution information and type of study should be in 14 pt, 

bold and capital letters; thesis or project name in 16 pt, bold and capital letters; author 

and advisor name in 14 pt, bold and capital letters; place and date information in 14 

pt, bold and capital letters. 

 

3.1.2. Inner Cover 

 

The thesis or project's inner covers are made according to examples from Appendix D 

and Appendix E. Institution information, and study type should be in 14 pt, bold, and 

capital letters; the thesis or project name in 16 pt, bold, and capital letters; author and 

advisor name in 14 pt, bold, and capital letters; location and date information in 14 pt, 

bold, and capital letters. 

 

The names of the thesis advisor and other members of the thesis jury must appear on 

the inside cover of the thesis.  

 

3.2. Introduction Pages 

 

3.2.1. Chapter Title Page 

 

The chapter title should start 3.5 cm (min.) from the top of the page and be written in 

capital letters with 1.5 line spacing. Sections (excluding Introduction and Conclusion) 

should be numbered with Roman numerals and capitalized (Example: CHAPTER IV). 

The words in the title should be whole; no abbreviations or formulas should be used. 

The title of the chapter should be written in 16-point, bold, and all capital letters. The 

rest of the page should be written in the font and size used in the text. Each chapter 

should start on a new page. Each chapter should have a short title that reflects the 

chapter's content. The format of the headings and subheadings of the chapters should 

be consistent in font and font size throughout the chapters. 
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The chapter number (CHAPTER I) appears on the first line, and the chapter title 

appears one space below. The title is written in bold and capital letters. The format of 

the headings and subheadings of the chapters should be consistent in font and font size 

throughout all chapters. 

 

 

 

Subheadings should be written with one line space after the text, capitalizing only the 

initial letter (except conjunctions). Subheading numbering can start with two digits 

and up to five digits. With the advisor’s approval, the thesis author may choose a 

numbering style consistent with the field's writing tradition. 

 

 

 

 

 

 

 

 

 

 

 

How to do it? 

 

In the numbering of subheadings, the first 

number represents the chapter number, and 

the second number indicates the order of 

the heading within that chapter. 

 

 For example, the fourth heading in 

CHAPTER II should be written as '2.4. 

Heading.' If subheadings are extended and 

further topics are covered, the numbering 

continues as '2.4.1.', '2.4.2.', and so on. 
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In the titles created in the thesis or project, signs such as long dashes (-) or slashes (/) 

should not be used, and the relevant part should be indicated with a conjunction 

appropriate to the title's meaning. In addition, the ampersand (&) can only be used in 

English theses and dissertations. 

 

Introduction and Conclusion sections must remain unnumbered and be written as 

INTRODUCTION and CONCLUSION in uppercase. For an example, see the 

Thesis/Project Writing Template.  

 

3.2.2. Academic Honesty Attestation  

 

See Appendix G for the Academic Honesty Attestation. This page must be signed and 

attached to the thesis during the binding process after completing all relevant processes 

after the thesis defense. For graduation projects, this page must also be signed and 

attached to the project. 

 

 

 

 

 

A blue ink pen must be used to sign this page. 

 

3.2.3. Öz 

 

Abstracts are self-contained texts that usually begin by stating the study's aims. They 

briefly describe the methodology, outputs, essential conclusions, and final 

recommendations. Authors are advised to write the Abstract as soon as they have 

completed their thesis or project. 

 

How to do it? 

 

The 'Academic Honesty 

Attestaion’ heading should 

be written in ALL CAPITAL 

LETTERS, with Times New 

Roman (TNR) font, size 12, 

and centered on the page. 

https://sgs.ihu.edu.tr/en/thesis-project-template
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The Öz should be 300 words at maximum. A maximum of six words should be 

included as keywords. For a sample Öz, see Appendix I. 

 

 

 

3.2.4. Abstract 

 

The Abstract page follows the Öz page. The abstract is the English translation of the 

Öz page. A sample Abstract page is provided in Appendix J. 

 

Regardless of the language of the thesis or project, it is mandatory to include an 

abstract page in Turkish and English in every study. 

 

 

How to do it? 

 
Keywords should be listed in alphabetical order, 

with the first letter of each word capitalized. 

 

The name, program, student number, ORC-ID, 

and reference number must be specified. 

Additionally, the name and title of the 

thesis/project advisor should be written in Turkish 

in the abstract and in English in the Abstract 

section. The thesis defense date should be added 

before the page number, in the format of month 

and year. 

How to do it? 

 
Using the Font and Paragraph 

sections in the 'Home' tab, the 'Öz' and 

'Abstract' headings should be written 

in ALL CAPITAL LETTERS, with 

Times New Roman (TNR) font, size 12, 

and centered on the page. 
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3.2.5. Dedication and Acknowledgment 

 

Both dedication and acknowledgments are optional sections. If the author adds these 

pages, they should be on separate pages with separate page numbers. 

 

The dedication page does not need a title. The other should be titled 

“Acknowledgements” or “Preface.” The title should be centered between the margins 

and without punctuation. 

 

 

 

 

 

 

 

 

3.2.6. Table of Contents 

 

The table of contents should include general headings, chapter headings, subheadings, 

references, appendices, and curriculum vitae. All headings in the table of contents 

should indicate the corresponding page numbers. The heading “Table of Contents” 

should be centered between the margins and the main headings should be written in 

boldface starting from the left margin. Subheadings should be indented, starting from 

the inside, and written in non-bold type (bold). The table of contents should be created 

automatically with the help of the Word program. See Appendix L for a sample Table 

of Contents. 

How to do it? 

 
Using the Font and Paragraph 

sections in the 'Home' tab, the 

'Dedication' and 

'Acknowledgment' headings 

should be written in ALL 

CAPITAL LETTERS, with Times 

New Roman (TNR) font, size 12, 

and centered on the page. 
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How to do it? 

 

By clicking the small arrow in the bottom right corner of the 

'Styles' section in the 'Home' tab, the heading styles menu opens. 

Headings with the same format are categorized and named, and 

selected individually throughout the entire thesis. For example, 

Heading 1 can be selected for chapter headings that are bold, 

16-point, and written in capital letters. Subheadings should be 

indented according to the chapter headings. 
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How to do it? 
 

Required adjustments and configurations are 

made for each heading style as illustrated. 

Style Source: Normal, Next Paragraph Style: 

Heading 1 (the appropriate style for each 

heading applies). 

 

To adjust your subheadings, first, the 

heading style is named. 

 

The Style Source should be set to Normal, 

and the Next Paragraph Style should be the 

same as the current heading. (For example, 

if the style is named 'Heading 2,' the Next 

Paragraph Style should also be set to 

Heading 2.) 
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How to do it? 
 

Once the heading styles are completed, 

click on the 'Custom Table of Contents' 

section in the References tab. In the 

window that opens, adjustments are 

made in the 'Table of Contents' section 

as shown in the image. Pay attention to 

the levels shown in the 'Show Levels' 

section. The number of heading levels 

created should be added to this field. 

Then, click the 'OK' button. 
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3.2.7. List of Tables 

 

Where necessary, a “List of Tables” should be inserted immediately after the table of 

contents. 

 

The heading “List of Tables” should be centered between the margins, and entries 

should start from the left margin. All headings in the list of tables should be indicated 

by their corresponding page numbers. The list should be created with 1.5 line spacing. 

The list of tables should be prepared automatically with the help of the Word program. 

If coloring is required in the tables, no color other than gray and its shades should be 

used. 

 

3.2.8. List of Figures and Illustrations 

 

The list of figures and illustrations should be on separate pages, just like the list of 

tables. Headings in the list of figures should also be 1.5-line spacing. The list of figures 

and images should be prepared automatically with the help of the Word program. 

 

 

 

 

 

 

 

 

 

How to do it? 
 

First, select a table heading from 

the Thesis Writing Template and 

double-click the Format Painter in 

the 'Home' tab. 

Then, the Format Painter is applied 

to all table and figure headings in 

the thesis. The format is applied 

separately for each table and figure 

by scanning the style from the 

template file. 

To adjust your subheadings, first, 

the heading style is named. 
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How to do it? 

 

After completing the formatting with the 

Format Painter, click the 'Insert Table 

of Figures' button in the References tab 

to automatically generate the list of 

tables and figures. Select 'Figure' as the 

caption label and click the 'Options' 

button. 

 

In the Options section, choose 'Caption' 

as the style and click the 'OK' button. 

How to do it? 
 

Headings listed under a single title 

are separated and listed as table, 

image, and figure lists. 

 

Each list is formatted according to 

the guidelines. (Each heading 

should be set to 12-point, Times 

New Roman, normal, with a 1.5 cm 

spacing.) 



 

  25  

3.2.9. List of Symbols and Abbreviations 

 

If the author provides a list of symbols and abbreviations, they should follow a format 

consistent with accepted practice in the field. Headings in the list should be 1.5 line 

spacing. Click here for the list of abbreviations published by the Turkish Language 

Association (TDK).  

 

 

 

3.3. Main Text 

 

3.3.1. Main Text Structure 

 

The main text can be divided into as many sections as necessary. The main text should 

be written in 12-point font and Times New Roman font. Indentation should not be used 

at the beginning of paragraphs One blank line must be left between paragraphs. This 

does not mean “space before and after”; instead, the paragraph spacing setting must be 

set to 12 pt. 

 

 

https://tdk.gov.tr/wp-content/uploads/2019/01/K%C4%B1saltmalar_Dizini.pdf
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3.3.2. Visual Materials: Tables and Figures 

 

Visual materials consist of tables, figures, images, and graphics. Tables present data 

in tabular form, listing text and/or figures in titled columns and rows. All visuals can 

be categorized under figures, including maps, diagrams, graphs, charts, photographs, 

drawings, and diagrams. 

 

Nasıl yaparım? 

 

To open the paragraph settings from 

the Page Layout tab, double-click the 

area marked with an arrow in the 

image, and the Paragraph Indentation 

and Spacing settings page will open. 

Except for the areas specifically 

mentioned in the guidelines, the line 

spacing throughout the text should be 

set to 1.5 cm. 

 

As shown in the image, set the 'Before' 

and 'After' spacing to 0 pt, and select a 

line spacing of 1.5. 
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Tables, graphs, and charts cannot be inserted as pictures. They must be created by the 

author using appropriate programs. 

 

The source information specified for visual materials such as tables, figures, graphics, 

etc., used in the thesis or project should be written in 1.5 line spacing, 10-point font 

size in non-bold type. 

 

 

 

 

i. Placement of Visuals such as Tables, Figures, Graphics, etc.: Visual aids may be 

placed anywhere in the text, but the general rule of thumb is that they should be as 

close as possible to the section of the text to which they refer. If the table or figure is 

inserted into the text and is less than one page, then it should be separated from the 

text by 1.5 line space above and below. Tables should fit on the page where they are 

located according to the page size. In cases where it cannot fit: 
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• In order not to disrupt the flow of the text, the continuation of the table that 

extends to the next page can be indicated at the top of the table (e.g., Table 1.1. 

continuation), 

• Again, without disrupting the flow of the text, the text size can be reduced to 

at least 10 points in the table, 

• Or the author may collect all the tables and/or figures in the chapter in the 

Appendix. In this case, tables come before figures.  

 

All tables, figures, and other visual aids should be cited in the text. Tables and figures, 

especially large-sized visual materials, should be prepared to facilitate binding and 

storage. Pages containing illustrations should be numbered and listed under a separate 

heading with the relevant page number. 

 

ii. Numbering and Table/Figure/Graphic etc. Titles: Figures and tables should be 

numbered in the order they appear in the text. The number of a figure/table should 

match the number (or letter) of the chapter (or appendix) to which it belongs. 

Numbering is done in two digits. The first digit represents the chapter or appendix, and 

the second digit represents the order of the figure or table within the chapter or 

appendix. The first table of Chapter I will be titled Table 1.1. Similarly, the first figure 

of Chapter II will be titled Figure 2.1. according to this scheme. Similarly, the first 

table in the first appendix should be numbered Table A.1. and the first table in the 

second appendix should be numbered Table B.1. 

 

The title of a table should be placed one line space above the top border of the table. 

The title of a figure should be placed one line space below the bottom border of the 

figure. Table and figure captions should be bolded in 12-point type. The font size and 

type of the title should be the same as the font size and type used in the rest of the text. 

The author should choose a font size that is easy to read, especially for tables, axis 

scales, axis titles, legends, tables, and diagrams. 

 

For images that require more than one page, the images on the following pages should 

be titled using the same title, indicating that they continue the image on the first page.  
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For example, the second page of Figure 2.1 should be titled “Figure 2.1 

(continuation)”. 

 

 

 

A table or picture can be placed on its side by turning it ninety degrees 

counterclockwise from its normal position. In landscape layout, the title of a figure or 

table should be arranged so that it is read from the bottom upwards, i.e., in the same 

direction as the figure/table. When using a landscape layout, the whole page should 

only be reserved for that table/figure. Margin and page numbering requirements are 

the same for the rest of the thesis or project. 

 

iii. Large-Scale Materials: Large-scale visual materials may be reduced to fit on one 

page per the margin and page numbering rules given in these guidelines, provided that 

they do not adversely affect the readability and visibility of the original visual material. 

 

A large-scale image that cannot be scaled down to fit on a page can be used as follows: 

 

i. As pocket material: Oversized materials may be folded into a pocket 

and attached to the inside back cover of the thesis. The visual material should be 

numbered and placed in an envelope, and page numbers should be listed in the 

appropriate list of tables or figures. The large-scale material itself may be classified as 

How to do it? 

 

If a table or figure is split 

across pages, the table or 

figure is divided, and the 

portion that continues on 

the next page is labeled as 

Table/Figure 1.1. (cont.) 
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an appendix. In this case, it should be listed in the Table of Contents under the heading 

Appendices. 

 

ii. As a folding sheet: Oversized material can be folded and attached to a page. The 

material should be folded so that it is not cut during trimming in the binding machine. 

 

Photographic images must be originals or high-quality copies of the originals. Black-

and-white photocopies of photographs are not acceptable. Color may be used in figures 

and photographs as long as all copies are color photocopied. If additional audiovisual 

material (e.g., videotape, DVD, etc.) is required to accompany or complement the text, 

it must be referred to in the text and submitted with the thesis or project. 

 

3.3. Use of Letters and Symbols 

 

Bullet points should be made by providing an example. The researcher can use letters 

or symbols as bullet points. Avoiding the use of Arabic numbers should be preferred 

so as not to confuse the thesis subheadings and the bulleting. Letters or symbols should 

also be used for minor headings that are not numbered. 

 

For example: 

 

a. Data processing 

b. Visualization of data 

c. Drawing conclusions and confirmation 

Or 

i. Data processing 

ii. Visualization of data 

iii. Drawing conclusions and confirmation 

 

3.4. Formulas and Mathematical Expressions 

 

An equation editor must be used for mathematical formulas, equations, and 

expressions. Any reference to them must carry a numerical definition, which 

must be given in parentheses next to the right margin of the page. 
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3.5. Quotes 

 

Quotations of three lines or less should be included in the text, enclosed in double 

quotation marks, and written without italics. Quotations longer than three lines should 

be excluded from the text indented on the right and left and single-spaced. These 

quotations are also called block quotations. Quotation marks are not used for block 

quotations. Quotations should be used the same way as the original, and the source of 

the quotation should be provided in full. Parts of computer code can also be considered 

as quotations. 

 

Quotations longer than three lines should be excluded from the text indented on the right and 

left and single-spaced. These quotations are also called block quotations. Quotation marks are 

not used for block quotations. Quotations should be used the same way as the original, and the 

source of the quotation should be provided in full. 

 

 

Interview quotations longer than three lines should be separated from the main text 

and presented in italics, enclosed in quotation marks, in 12-point font size, and justified 

on both sides. Shorter quotations, consisting of three lines or fewer, should be 

incorporated into the main text with the same formatting features applied. 

Non-textual representation: 

“Quotations from interviews should be in quotation marks, italicized, 12-point font, 

and justified. Interview quotations should be in quotation marks, italicized, 12-point 

font, and justified.” 

 

In-text representation: 

Quotations from interviews should be enclosed in quotation marks, italicized, in 12-

point font, and justified "Quotations from interviews should be enclosed in quotation 

marks, italicized, in 12-point font, and justified." 

 

Verses and hadiths used in the text of the thesis or project files should be single-spaced, 

10-point font, bold, and centered. Only text in Turkish characters should be italicized. 

 
م َۚ يَتوََكَّلوُنَ َۚ م َۚ اٰياَتهَُُۚ زَادَت هُم َۚ ا۪يمَانا َۚ وَعَلٰى رَب ِّهِّ لَت َۚ قلُوُبهُُم َۚ وَاِّذاَ تلُِّيَت َۚ عَلَي هِّ رََۚ اٰللَُّۚ وَجِّ نوُنََۚ الَّذ۪ينََۚ اِّذاَ ذكُِّ مِّ  اِّنَّمَا ال مُؤ 

“Müminler o kimselerdir ki, Allah’ın adı anıldığında yürekleri titrer, kendilerine Allah’ın âyetleri 

okunduğunda bu onların imanlarını arttırır. Onlar yalnızca rablerine güvenirler.”  

Poetry quotations used in the text of the thesis or project files should be italicized, 
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single-spaced, in 10-point font, and left justified. 

 

Şimdi tekrar ne yapsam dedirtme bana yarabbi 

taşınacak suyu göster,kırılacak odunu 

kaldı bu silinmez yaşamak suçu üzerimde 

bileyim hangi suyun sakasıyım ya rabbelalemin 

tütmesi gereken ocak nerde? 

 

A poetry quotation written in Arabic script should be presented with the same 

formatting features as general poetry quotations and placed on the right side of the 

page. 

 

3.6. Footnotes and Endnotes 

 

Footnotes are placed at the bottom of the page, separated from the text by a half-

horizontal line. Single-line spacing is used to separate different footnotes on a page. 

Lengthy footnotes may be split and continue in the footnote section of the next page. 

In this case, it is indicated that this is a continuation of the footnote on the previous 

page by separating it from the text with a full horizontal line. Footnotes should be 

numbered consecutively using Arabic numerals (1, 2, 3...). The numbering may be 

specific to each chapter or continued throughout the thesis. Notes should be written in 

the same font used in the text, but the font size should be 10 points. 

 

Alternatively, endnotes can be used. Endnotes may follow each chapter or be placed 

at the end of the thesis or project before the references. If an endnote follows a chapter, 

it should begin on a separate page following the chapter to which it belongs. Authors 

should consult their thesis or project supervisor, as footnote practices vary widely 

across publications in different disciplines. The footnote writing styles that should be 

used according to the enrollment program can be found in Chapter IV, Table 4.1.  

 

3.7. Reference Materials 

 

Reference materials contain two elements: References and appendices. 

 

3.7.1. References 
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References should include all materials (books, periodicals, manuscripts, internet-

based resources, etc.) consulted while conducting the research and writing the text. 

The list should be in alphabetical order according to the author's surname. 

 

All materials may be listed in a single section, in which case this section should 

precede the “Appendices” (if any). In some disciplines, references may be listed at the 

end of each chapter rather than at the end of the thesis or project. 

 

This section does not contain a chapter number. The title should be centered 3.5 cm 

from the top of the page per the format of the section headings and margins used 

throughout the text. The references list starts with two single-line spaces below the 

title. Each reference entry is written with a single line spacing, and a single line spacing 

is used between each entry throughout the list. The page numbers of the references 

section should follow the numbering rules of the thesis or project in terms of font style 

and size. 

 

 

 

 

 

The style of listing and citing references in terms of font, layout, and punctuation varies 

in different academic disciplines. For this reason, the author must follow the reference 

style determined by the program/department in which the thesis or project is registered 

and accepted by the discipline. The writing styles used can be found in the table under 

the title of Section IV. 

 

The author should indicate the following points when referencing electronic resources: 

How to do it? 

 

Using the Font and Paragraph 

sections in the 'Home' tab, the 

'References' heading should be 

written in ALL CAPITAL 

LETTERS, with Times New 

Roman (TNR) font, size 16, and 

centered on the page. 
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• Title of the website 

• URL address of the website 

• Owner of the website (person, group, organization, etc.) 

• Date the information was placed on the site 

• Date the information was accessed from the site 

 

 

3.7.2. Appendices 

 

Supplementary material related to the text but containing very detailed information or 

data may be placed in a separate section. “Appendices” (or ‘Appendix’ if only one) 

may include various materials, such as computer printouts and programs, raw data, 

permission for thesis or project work, procedure descriptions and survey instruments, 

etc. Copied materials should be of letter quality and oversized materials may be 

included as folded pages or pocket material, as described in the previous section (see 

“Oversized Materials” above). 

 

If there is more than one appendix, the appendices should be identified as A, B, C, C, 

etc. The heading “Appendix” should follow the same format used for other section 

headings in the text. Likewise, the margins should be the same as the rest of the text. 

If there is more than one appendix, they should be displayed in the table of contents 

like subheadings. 

 

 

 

 

The title of each appendix should be included in the Table of Contents as a separate 

How to do it? 

 

Using the Font and Paragraph 

sections in the 'Home' tab, the 

'Appendices' heading should be 

written in ALL CAPITAL 

LETTERS, with Times New 

Roman (TNR) font, size 16, and 

centered on the page. 
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entry under the main heading “Appendices.” Appendix pages should be numbered 

consecutively using the same font and size as the numbering used in the rest of the 

thesis or project. The documents given in the appendices may be included in their 

original form.  

 

If your study is included in the study group that requires ethics committee permission 

(all kinds of research conducted with qualitative or quantitative approaches that require 

data collection from participants using survey, interview, focus group study, 

observation, experiment, interview techniques), the Ethics Committee Decision to be 

taken from the Social and Humanities Scientific Research and Publication Ethics 

Board of our University should be included in the Appendix. 

 

3.8. Curriculum Vitae (CV) 

 

A curriculum vitae should be attached at the end of theses and projects. The curriculum 

vitae is a short biographical sketch of the author, including contact information (e-mail 

address used), colleges and universities attended (after high school), diplomas, 

publications, teaching, and professional experience. The CV should be written in the 

third person and added to the Table of Contents as the last item. The page format 

(margins, size, font, and line spacing) should be consistent with the rest of the text. See 

Appendix N for a sample CV. 

 

Before the theses are uploaded to the National Thesis Center of the Council of Higher 

Education (YÖK), contact information such as e-mail is removed from the CV at the 

National Thesis Center's request within the scope of the Personal Data Protection Law 

(KVKK). 

 

 

 

  

How to do it? 

 

Using the Font and Paragraph 

sections in the 'Home' tab, the 

'Curriculum Vitae' heading 

should be written in ALL 

CAPITAL LETTERS, with 

Times New Roman (TNR) font, 

size 16, and centered on the 

page. 
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CHAPTER IV 

 

STYLE 

 

A thesis or project is the result of research conducted through formal methods and, 

therefore, holds the status of an official document. It should be written in a formal, 

impartial, and impersonal style. Academic writing requires the use of standardized 

language. Writers should avoid colloquial, redundant, and slang expressions. 

 

Since the rules on documentation styles differ in various disciplines, thesis or project 

writers should consult their thesis or project supervisor about recommended 

documentation style manuals. The most recent edition of the chosen citation style must 

be used. 

For access to the most up-to-date versions of citation styles: 

• APA Style Blog 

• Chicago Manual of Style Online 

• ISNAD Citation System 

The table below shows the thesis/Project reference documentation styles according to 

department.  
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Table 4.1. Reference Usage Styles According to Programs 

 

PROGRAM 

The Chicago 

Manual of 

Style 

 

(Latest Edition) 

APA: Publication 

Manual of the 

American 

Psychological 

Association 

 

(Current Edition) 

 

İSNADَۚAtıfَۚ

Sistemi / The 

ISNAD Citation 

Style 

 

(Sosyal ve Beşeri 

Bilimler alanı, 

güncel edisyon 

(Current Edition) 

Big Data and Business 

Analytics 
 ✓ 

 

Religious Studies  ✓ ✓  

Philosophical, Social, 

and Historical 

Fundamentals of 

Education 

 ✓ 

 

Managing Educational 

Institutions 
 ✓ 

 

Philosophy ✓   

Financial Economics  ✓  

Air Transport 

Management 
 ✓ 

 

Economics  ✓  

Management  ✓  

Public Law ✓   

Clinical Psychology  ✓  

Middle East Studies ✓   

Private Law ✓   

Psychology  ✓  

Radio, Television, and 

Cinema 
 ✓ 

 

Counseling Psychology  ✓  

Political Science and 

International Relations 
 ✓ 

 

Sociology ✓   

History ✓   

Islamic Studies ✓  ✓ 

Turkish Studies ✓   

International and 

Comparative Law  
✓  

 

New Media and 

Communication 
 ✓ 

 

Civilization Studies ✓ ✓  
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CHAPTER V 

 

THESIS/PROJECT WRITING IN ARABIC 

 

5.1. Required Fields in Arabic Thesis/Project 

 

Each thesis or project must include a Turkish outer/inner cover and a Turkish 

introduction. Below is a list of the Turkish sections that must be included in the text of 

each Arabic thesis or project. The list of required sections in each Arabic thesis or 

project text is as follows in the order given below. Required fields are marked with an 

asterisk. 

  

TURKISH PART 

 COVER PAGES* 

  Outer Cover (Turkish)* 

  Inner Cover (Turkish)* 

 INTRODUCTION PAGES* 

  Academic Honesty Attestation (Turkish)* 

  Öz (Turkish)* 

  Abstract (English)* 

 

ARAPÇA KISIM 

 COVER PAGES* 

  Outer Cover (Arabic)* 

  Inner Cover (Arabic)*  

 INTRODUCTION PAGES* 

  Abstract (Arabic)* Appendix K for Sample Abstract 

  Dedication (Arabic) 

  Acknowledgments or Preface (Arabic) 

  Table of Contents (Arabic)* Appendix M for Sample Table of Contents 

  List of Tables (Arabic) 
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  List of Figures and Illustrations (Arabic) 

  List of Symbols and Abbreviations (Arabic) 

MAIN TEXT (Arabic)* 

  Section Headings * 

  Main Text* 

REFERENCES (Arabic)* 

APPENDICES (Arabic) 

CURRICULUM VITAE (Turkish)* 

 

5.2. Text Features 

 

Other spelling rules apply to Arabic thesis or project writing except for the below 

features. The rules for writing a thesis or project in Arabic are given below. 

 

The margins on the page should be 4 cm on the right (binding side) and 2.5 cm on the 

other three sides. The page number should be written 0.75 cm from the page edge in 

the footer. All margins must be left blank. There should be no headings, footnotes, 

text, etc. in the margins. 

 

Areas that must be printed in Turkish should be printed on the right side of the volume. 

The outer/inner cover should be printed in Arabic from the left side of the volume. 

 

Arabic texts used in the thesis or project content should be written in Traditional 

Arabic font. 

 

The institutional information and type of study on the outer/inner cover should be in 

16 pt, bold and capital letters; the name of the thesis or project should be in 18 pt, bold 

and capital letters; the name of the author, the advisor should be in 16 pt, bold and 

capital letters, and the place and date information should be in 16 pt, bold and capital 

letters. See Appendix C for the sample Arabic outer cover and Appendix E for the 

inner cover. 

 

Section headings should be bold and in 18 pt. 
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The texts should be written in 15 pt. and traditional Arabic font, starting from the 

introductory pages.  

 

Subheadings should be aligned to the left, and their numbering should be written with 

Arabic numerals (1, 2, 3...). 

 

Page numbers should be written with Arabic numerals in the lower right corner of the 

page in 12-point Times New Roman font. 

 

Footnotes should be numbered consecutively using Arabic numerals at the bottom of 

the page, separated from the text by a half-horizontal line. The numbering may be 

specific to each chapter or may be continued throughout the thesis. Notes should be 

written in the font used in the text (Traditional Arabic), but the font size should be 13 

points. 

 

Accordingly, Turkish information should be written in 12-point Times New Roman, 

and Arabic information should be written in 15-point Traditional Arabic font. If the 

text does not fit, the title can be shortened, or the font size can be reduced not to distort 

the meaning. See Appendix S for a sample Arabic binding. 
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CHAPTER VI 

 

THESIS/PROJECT PROCESS 

 

6.1. Procedures to be Carried Out Before and After the Thesis Defense: 

 

For theses written in English, the student must check the language of their thesis using 

the English language writing-check program provided with the support of the Institute 

and obtain a report from the same program indicating the similarity score. The 

similarity score in this report must be 85% or higher. 

 

If the compliance rate is 85% and below, the student applies the corrections in the 

report and receives a new report by uploading this file to Grammarly again. 

 

The thesis text prepared by the student and the report from the English language 

writing-check program are sent to the advisor. If there are any unresolved issues under 

the "Correctness" section, the student must provide explanations for these by adding 

comments in the correction list area of the English language writing-check program 

report. 

 

The consultant receives a similarity report on the same file. The rate in the similarity 

report must be a maximum of 20%.  

 

The advisor submits the Thesis Defense Application Form, the final version of the 

thesis (in PDF format), the similarity report, and the English language writing-check 

program report to the Institute via the Department Secretariat at least one month prior 

to the proposed defense date. 

 

The Graduate School checks the incoming documents and approves the thesis defense 

application if the student's curriculum status, submitted reports, proposed jury, and 

thesis defense date are appropriate.  
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The thesis defense is held on the relevant date, and the advisor sends the Thesis 

Defense Proceedings Form to the Graduate School via the Department Secretariat 

within 3 days. 

 

After making the necessary corrections within 3 months for a master’s degree and 6 

months for a doctorate, the student who has been given a correction decision about 

their thesis carries out the processes in the thesis defense procedures again and makes 

the correction thesis defense in front of the same jury after receiving approval. 

 

If the thesis defense result is successful, the student sends the final version of the thesis 

with minor corrections and additions from the jury to sgs@ihu.edu.tr if registered to 

the School of Graduate Studies and medit@ihu.edu.tr if registered to the Alliance of 

Civilizations Institute.  

 

The Institute obtains the language check report from the English language writing-

check program database and grants approval to the student if the similarity score is 

85% or above. 

 

If the ratio is inappropriate, the file is sent to the student for corrections. If the 

corrections to be made are prominent, the student and the student's thesis file are 

directed to writingcenter@ihu.edu.tr. 

 

The student who receives approval in the language check sends the Word version of 

the thesis together with the Thesis/Project Copy-Editing Evaluation Request Form to 

thesischeck@ihu.edu.tr if they are registered to the School of Graduate Studies and 

to medit@ihu.edu.tr if they are registered to the Alliance of Civilizations Institute. 

 

The Graduate School checks the writing guide requirements. If the file is not according 

to the Thesis/Project Writing Guide, it adds correction notes and sends them to the 

student. The student applies the corrections according to the Thesis/Project Writing 

Guide and sends them back for checking. 

 

mailto:sgs@ihu.edu.tr
mailto:medit@ihu.edu.tr
mailto:writingcenter@ihu.edu.tr
mailto:thesischeck@ihu.edu.tr
mailto:medit@ihu.edu.tr
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If the thesis complies with the Thesis/Project Writing Guide because of the corrections 

made, the thesis file is sent to the student for printing. 

 

The student prints the thesis per the Thesis/Project Writing Guide and submits it to the 

Graduate School with the requested documents. 

 

The student's graduation process is initiated if the thesis edition is appropriate and 

meets the graduation requirements. 

 

6.2. Procedures to be Carried Out Before and After Project Submission: 

 

The project delivery process should be completed by following the steps below: 

 

• If the student has changed the project topic, they fill out the Thesis/Project 

Advisor/Topic Notification/Change Form, complete the signatures, and submit it to 

the Graduate School through the Secretariat of the Department. 

 

• For projects written in English, the student, with the support of the Institute, performs 

a language check of the project through the English language writing check program 

and obtains a report indicating the compliance rate from the same program. The 

compliance rate in this report must be 85% or more.  

 

• If the compliance rate is 85% or less, the student applies the corrections in the report 

and gets a new report by uploading the file to Grammarly. 

 

• The project text prepared by the student and the English language writing check 

program report are submitted to the advisor. If there are any unresolved issues under 

the 'Correctness' section, the student should provide explanations for these issues in 

the relevant section of the English language writing check program report, attaching 

them as comments in the area designated for the correction list. 

 

• The advisor receives a similarity report on the same file. The ratio in the similarity 

report should be at most 25%. 

 



 

  44  

• If the similarity report meets the appropriate criteria, the consultant will send the 

English language writing check program report along with the similarity report to the 

Institute.  

 

• The School of Graduate Studies checks the incoming documents and informs the 

student to start the form condition control process if the reports are appropriate. 

 

• If the ratio is inappropriate, the file is sent to the student for corrections. If the 

corrections to be made are prominent, the student and the student's thesis file are 

directed to sgs@ihu.edu.tr. 

 

• The student who receives approval in the language check sends the Word version of 

the thesis together with the Thesis/Project Copy-Editing Evaluation Request Form to 

thesischeck@ihu.edu.tr if they are registered to the School of Graduate Studies and 

to medit@ihu.edu.tr if they are registered to the Alliance of Civilizations Institute. 

 

• The Graduate School checks the writing guide requirements. If the file is not 

according to the Thesis/Project Writing Guide, it adds correction notes and sends them 

to the student. The student applies the corrections according to the Thesis/Project 

Writing Guide and sends them back for checking. 

 

• If the project complies with the Thesis/Project Writing Guide because of the 

corrections made, the project file is sent to the student for printing. 

 

• The student prints the project per the Thesis/Project Writing Guide and submits it to 

the Graduate School with the requested documents. 

 

• The student's graduation process is initiated if the hardcover project is appropriate 

and meets the graduation requirements. 

mailto:sgs@ihu.edu.tr
mailto:thesischeck@ihu.edu.tr
mailto:medit@ihu.edu.tr
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IBN HALDUN UNIVERSITY 

SCHOOL OF GRADUATE STUDIES/ 

ALLIANCE OF CIVILIZATIONS INSTITUTE 

DEPARTMENT OF ECONOMICS 

 

 

 

GRADUATION PROJECT 

 

 

 

MARKET ECONOMY AND EXCHANGE RATES  

IN TURKEY 
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PROJECT ADVISOR 

PROF. ESRAَۚBİLGİLİ 
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IBN HALDUN UNIVERSITY 

SCHOOL OF GRADUATE STUDIES/ 

ALLIANCE OF CIVILIZATIONS INSTITUTE 

DEPARTMENT OF ECONOMICS 

 

 

 

MASTER'S/DOCTORATE THESIS 

 

 

MARKET ECONOMY AND EXCHANGE RATES  

IN TURKEY 

 

 

 

AHMET YILMAZ  

 

 

 

THESIS ADVISOR 

PROF. ESRAَۚBİLGİLİ 

 

 

 

 

ISTANBUL, 2024
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THIS OUTER COVER APPLIES TO THOSE WRITING THESES 

IN ARABIC. 

 

جامعة ابن خلدون                                                                                                         

                                                               معهد الدراسات العليا                                          

 قسم العلوم الإسلامية

 
 رسالة الماجستير 

 

تصرّف النووي في عبارة ابن الصّلاح بالتغيير 

 والزيادة في كتابيه الإرشاد والتقريب 
 

 

 عبد الباسط بابا عيسى

 

 مشرف الرسالة

 الدكتور حمزة البكري 
 

 

٢٠٢١إسطنبول،   
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IBN HALDUN UNIVERSITY 

SCHOOL OF GRADUATE STUDIES/ 
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PROJECT APPROVAL PAGE 

 

I have read this project, and I have decided that it is sufficient in terms of scope and 

quality to obtain a master's degree in ... 

 

 

 

 

 

Project Advisor 
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_____________________________ 

 

 

_________________________ 
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by Ibn Haldun University Institute of Graduate Studies. 
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in accordance with academic rules and ethical conduct. I also declare that, as required 

by these rules and conduct, I have fully cited and referenced all material and results 

that are not original to this work. 
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ÖZ 

 

TÜRKİYE’DE PİYASA EKONOMİSİ VE DÖVİZ KURLARI 

 

Yılmaz, Ahmet 

............ Yüksek Lisans/Doktora Programı 

Öğrenci Numarası: 123456789 

Open Researcher and Contributor ID (ORC-ID): 0000-000X-XXXX-XXXX 

Ulusal Tez Merkezi Referans Numarası: 103XXXXX 

 

Tez/Proje Danışmanı: Prof. Dr. Esra Bilgili 

(varsa) İkinci Tez Danışmanı: Doç. Dr. ... 

Eylül 2024, 156 sayfa 

 

(300 kelimeyi geçmeyen bir öz buraya konulacaktır.) 

 

Anahtar Kelimeler: Azami 6 anahtar kelime, aralarında virgül olacak şekilde 

yazılmalı. 

Örneğin: Anahtar Kelimeler: Piyasa Ekonomisi, Döviz Kurları 
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ABSTRACT 

 

MARKET ECONOMY AND EXCHANGE RATES IN TURKEY 

 

Yılmaz, Ahmet 

MA/LL.M./PhD in ...... 

Student ID: 123456789 

Open Researcher and Contributor ID (ORC-ID): 0000-000X-XXXX-XXXX 

National Thesis Center Reference Number: 103XXXXX 

 

Thesis/Project Supervisor: Prof. Esra Bilgili 

(if any) Thesis Co-Advisor: Assoc. Prof.............. 

September 2024, 156 Pages 

 

(Write an abstract with a maximum of 300 words) 

 

Keywords: Write up to 6 keywords. Each keyword must be separated with a 

semicolon. 

For example: Keywords: Market Economy, Exchange Rates 
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THIS ABSTRACT PAGE IS AN EXTRACT FROM AN ARABIC THESIS. THE 

CONTENT INFORMATION MUST BE EDITED BY THE THESIS AUTHOR. 

 

 لملخص

 

 تصرّف النووي في عبارة ابن الصّلاح بالتغيير والزيادة في كتابيه الإرشاد والتقريب
 

الباسط  عبد عيسى، بابا  

( % في إنجليزية٣٠) الإسلامية دراسات في ماجيستير  

   ١٠٠٨١٠٤٩١رقم الطالب: 

 ٣٩٠٢-٧٦٩٣ -٠٠٠٢-٠٠٠٠ Open Researcher and Contributor ID (ORC-ID): 

٤٨٦٧١٤٠١المرجعي لمركز الرسائل الوطني: رقم   

البكري   حمزة مساعد أستاذ: الرسالة مشرف   

 صفحة  ١٦١،  ٢٠٢١يونيو 

 

من أمهات المصادر في علوم الحديث،   معرفة أنواع علم الحديثيعتبر كتاب ابن الصّلاح  

 الحديثمن أهم مختصراته. لم يختصر النووي كتاب علوم  التقريب  و  الإرشادالنووي    اوكتاب

فحسب وإنما زاد فيه زيادات وتصرّف في عبارات ابن الصّلاح في مواضع كثيرة. تتحدث 

هذه الدراسة عن هذه الزيادات التصرفات التي قام بها النووي في عبارات ابن الصّلاح في  

وتحاول أيضًا البحث عن الأسباب التي دعت النووي إلى هذه الزيادات    التقريب،و  الإرشاد

، والكشف عن مرام النووي فيها، وتأثيرها فيمن  التقريبو  الإرشادوالتصرفات في كتابيه  

 بعده.  

وتصرف  ابن الصّلاح، النووي، زيادات، وتغييرات،الكلمات المفتاحية: 
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TABLE OF CONTENTS 

ÖZ ............................................................................................................................... iv 

ABSTRACT ................................................................................................................ v 

İTHAF ........................................................................................................................ vi 

TEŞEKKÜR ............................................................................................................. vii 

İÇİNDEKİLER ....................................................................................................... viii 

TABLOLARَۚLİSTESİ .............................................................................................. ix 

ŞEKİLLERَۚLİSTESİ ................................................................................................. x 

GÖRSELLERَۚLİSTESİ ........................................................................................... xi 

SEMBOLLER VE KISALTMALAR ..................................................................... xii 

BÖLÜMَۚIََۚۚGİRİŞ ....................................................................................................... 1 

1.1. Şekil ve Tablolar ........................................................................................... 1 

1.2. Görsel Malzemeler ........................................................................................ 2 

BÖLÜM II LİTERATÜRَۚTARAMASI ................................................................... 3 

2.1. Görsel Malzemeler ........................................................................................ 3 

2.2. Alıntılar ......................................................................................................... 3 

2.3. Dipnotlar ve Son Notlar ................................................................................ 4 

2.4. Referanslar ..................................................................................................... 5 

2.4.1. Alıntı Yapılan Çalışmalar .......................................................................... 5 

2.4.1.1. Stil .......................................................................................................... 5 

BÖLÜM III SONUÇLAR.......................................................................................... 7 

3.1. Dipnotlar ve Son Notlar ................................................................................ 7 

REFERANSLAR ........................................................................................................ 8 

EKLER EK A ............................................................................................................. 9 

EK B .......................................................................................................................... 10 

ÖZGEÇMİŞ .............................................................................................................. 11 
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THIS TABLE OF CONTENTS PAGE APPLIES TO ARABIC THESES. IT IS 

TAKEN AS AN EXAMPLE FROM AN ARABIC THESIS. THE CONTENT 

INFORMATION MUST BE EDITED BY THE THESIS AUTHOR. 
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CURRICULUM VITAE 

 

Full Name: 

Ahmet Yılmaz 

 

Contact Information: 

 

E-posta (1): adsoyad@ihu.edu.tr 

E-posta (2): adsoyad@gmail.com 

 

Education: 

 

2006 – 2010  BA in Management, George Mason University, ABD 

 

2010 – 2012  MA in Economics, İbn Haldun University, Türkiye 

 

 

Work Experience: 

 

2010 – 2015  Turkish Airlines 

 

Publications (if exits): 

 

1. 

 

2. 
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RULES TO BE FOLLOWED FOR THE BINDING OF MASTER'S AND 

DOCTORAL THESES 

 

1. Black binding cloth must be used for master's theses and navy blue for doctoral 

theses. 

2. The cover should be made of 1.8 mm cardboard, and the spine should be 2.5 mm. 

3. Paper and cardboard dimensions should be as follows for both theses and 

dissertations; 

➢ Paper dimensions: 20.0 x 29 cm. 

➢ Cardboard dimensions: 20.5 x 29.5 cm. 

4. The spine must be flat and 5 mm wider than the cover. Theses with a thickness of 

less than 0.75 cm are not required to have a title on the spine. 

5. The binding cloth should be flat-cut, and the inside of the cover should be covered 

with domestic cardboard (180 grams). 

6. The shiraz and bookmark must be red. 

7. A blank white page should be placed after the front cover and before the back cover. 

8. The thesis text should be printed on one side. 

9. The font size for the front cover should be 16-point Times New Roman, and 12-

point Times New Roman font should be used for the spine. On the spine, 2 cm. space 

should be left from the top and bottom. For very long thesis titles, only the first part of 

the title can be used if it does not fit. The binding should be printed with a stamp 

or digital printing machine.  

10. Volume lettering should be printed in yellow (gold) color.
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RULES TO BE FOLLOWED REGARDING THE PRINTING OF MASTER'S 

GRADUATION PROJECTS 

 

1. American binding (white cardboard cover) must be used for master's graduation 

projects. 

2. Graduation projects must be covered with local cardboard (180 grams). 

3. Paper and cardboard dimensions should be as follows for final projects; 

➢ Paper dimensions: 20.5 x 29cm. 

➢ Cardboard dimensions: 20.5 x 29.5 cm 

4. The spine of the book should be straight. 

5. The project text must be printed on one side. 

6. The font size for the front cover should be 16-point Times New Roman, and 12-

point Times New Roman font should be used for the spine. On the spine, 2 cm. space 

should be left from the top and bottom. For very long thesis titles, only the first part of 

the title can be used if it does not fit. If the spine is less than 0.75 cm, writing the title 

on the spine is not obligatory.  
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SIMILARITY REPORT CRITERIA 

 

Similarity report of thesis or project work; 

 

1. Excluding the sections such as “cover, preface, abstract, table of contents, lists of 

symbols-abbreviations, lists of figures-tables, references, appendices, curriculum 

vitae, etc.” from the main text of the thesis in the similarity check process, (The 

similarity report should be taken by selecting the part from the introduction to the last 

chapter of the thesis). 

 

2. Excluding the parts given as block quotations in quotation marks in the thesis text 

(definitions, articles of law, aphorisms, verses, etc.) in the reporting process,  

 

3. In the reports, the word exclusion threshold must be limited to a minimum of 8 

(eight) and a maximum of 250 (two hundred fifty) consecutive words, and the options 

'Exclude quotes', 'Exclude bibliography', and 'Exclude matches' must be enabled. If 

these options are not enabled, the similarity rate must not exceed the thresholds 

specified below. 

 

4. Evaluating the inclusion of other filtering options of the similarity software in the 

reporting by the thesis advisor, 

 

5. In the report received after the similarity check process for graduate theses, 

a. Similarity rate for graduate theses 20%, 

b. Graduation projects 25%, 

c. Ensuring that the match rate with a single source is 2%, 

 

6. By excluding the sources such as the publications of the student's graduate thesis 

and the texts of the legislation the student benefited from or the vital work on which 

the study is carried out,  

 

7. If there is a "translation matching" option in the similarity system, enabling it and 

checking the similarity, 
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8. If the work is to be checked for the similarity test, make sure it does not go to the 

principal repository of the relevant software, and if rechecked, it is uploaded to the 

appropriate systems with the "no repository" option to avoid the similarity rate 

problem, 

 

9. The following options can be activated in the controls if they exist: homework 

repository, existing and archived internet and periodicals, journals, and other 

publications options on the similarity system/systems,  

 

10. The similarity report is examined by the thesis advisor personally, and overlaps 

that cannot be counted as similarities are removed from the report with the filter option 

before the report is printed, 

 

11. Paying attention not to upload studies belonging to people who are not members 

of the institution to the similarity system, 

 

12. In addition to the responsibility for the similarity report, the study should be taken 

with the conclusion that the part of the study, excluding the similarity ratio, is the 

author's work. 

 

13. If generative AI tools are used in the thesis, the author must comply with the 

Council of Higher Education’s “Ethical Guide on the Use of Generative AI in 

Scientific Research and Publication Activities.” 
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SIMILARITY REPORT CRITERIA 

 

Illustration T.1. Sample Similarity Report Criteria (Previous Version) 
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Illustration T.2. Sample Similarity Report Criteria (Updated Version) 
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THESIS ENGLISH LANGUAGE CONTROL PROCESS 

 

Illustration U.1. Thesis English Language Control Process 
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PROJECT ENGLISH LANGUAGE CONTROL PROCESS 

 

Illustration V.1. Project English Language Control Process 
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THESIS FILE CHECKLIST 

 

When writing a thesis or project, our graduate students must follow the thesis writing 

guide specified by Ibn Haldun University Graduate School of Graduate Studies. The 

guide is the first document used to control the thesis or project. 

 

The table below has been prepared as an auxiliary document to facilitate compliance 

with the thesis or project writing guidelines. By examining each item individually, you 

can see what you need to pay attention to in the formal control of your thesis or project. 

Making the necessary arrangements in your file according to the thesis or project 

writing guide and the points below will facilitate your thesis or project control process.  

 

In this table, please mark the points to be followed according to the 

guidelines in the next column after you have processed your file. Checked? 

Have you set a margin of 4 cm from the left edge of your page (binding 
side) and 2,5 cm from the other edges?  

 

Have you prepared the outer and inner covers according to the 
Thesis/Project Writing Guide?  

Institution information and type of work TNR, 14 pt, bold and capital letter 
Thesis/project title TNR, 16 pt, bold and capital letter 
Author, advisor name TNR, 14 pt, bold and capital letter 
Location and date TNR, 14 pt, bold and capital letter 

 

 

Have you prepared your Abstract / Abstract pages to include a maximum 
of 300 words according to the thesis/project writing guide? 
 
Your keywords should include a maximum of six words and should be alphabetized. 

 

Have you written your Öz, Abstract, and Preface in ALL CAPS, TNR, 
12-point font, and aligned to the center of the page? 

 

Have you written your References, CV and Appendix titles in ALL 
CAPS, TNR, 16-point font, and aligned to the center of the page? 

 

Have you written the titles Table of Contents, List of Figures, List of 
Tables, List of Abbreviations in ALL CAPS, TNR, 12 pt, bold and 
center aligned? 

 

Have you prepared the table of contents automatically and according to 
the thesis/project writing guide? 
 
Title numbering should be at least two and at most five digits. 

 

Have you automatically prepared tables and figure lists according to the 
thesis/project writing guide? (if it exists) 

 

Have you automatically prepared tables and figure lists according to the 
thesis/project writing guide? (if it exists) 
 
Click here for the list of abbreviations published by the Turkish Language Association 
(TDK). 

 

Page numbers should be arranged as follows: 
- Bottom and right of the page, 
- Top information at the top and bottom information at the bottom 

0,75 cm, 
- Text font format 12 point, Times New Roman, 1.5 line spacing, 

 

Your page numbers should continue with Roman numerals from 
ABSTRACT to CHAPTER I. After CHAPTER I, the page number 
should start with 1 and continue throughout the thesis. 

 

Have you written all your chapter titles in ALL CAPS, bold TNR, 16-
point font, and center aligned? Does each chapter start on a new page? 
 

 

https://tdk.gov.tr/wp-content/uploads/2019/01/K%C4%B1saltmalar_Dizini.pdf
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The chapter title should start 3.5 cm (min.) from the top of the page and be written in 
capital letters with 1.5-line spacing. Sections should be numbered and capitalized 
using Roman numerals. 

Are other-level subheadings written only in Initials Capitalized, TNR, 
12-point font, bold, and left-aligned? 
 
Subheadings should be left-aligned and numbered with numbers. 

 

Your thesis text should be edited as follows: 
- Text leaning on both sides, 
- Font format is 12 point, Times New Roman, 
- 1.5 line spacing between paragraphs, 
- 1.5 line spacing between subheadings and paragraphs. 
-  

Words cannot be split when moving from one page to another. At least two lines of a 
paragraph must appear at the beginning and end of each page. Headings and 
subheadings must be followed by at least two lines of a paragraph. 

 

If the thesis text is itemized, did you use symbols instead of numbers? 
 
There should be no underlined words in the thesis. 

 

According to the thesis writing guide, have you prepared the table and 
figure representations (title, source, font size, etc.) in your thesis text (if 
any)? 

 

Have you typed the footnotes in 10 font sizes, using Times New Roman 
font, 1 line spacing, and justified? (if it exists)  

 

Have you written the block, interview, and poetry excerpts and the 
representation of verses and hadiths according to the thesis writing 
guide? (if it exists) 

 

Have you prepared the equations according to the thesis writing guide? 

(if it exists) 

 

Did you use the citation style of the program you wrote your thesis in in-
text (citation) and references? 

 

Have you prepared your references section with 1 line spacing, justified, 
and alphabetized according to the author's last name? 
 
Each reference entry is single-spaced within itself, and 1 line spacing is used between 
each entry throughout the list. 

 

For reference, are two or more lines long, or are the second and 
subsequent lines shown 1 cm inside?  

 

In the Appendices section, if any, does each appendix have an appendix 

letter and a title (e.g., Appendix 5. Survey Questions)? 

 
If there is more than one appendix, appendices should be identified as A, B, C, Ç, etc. 
Each appendix heading should be included as a separate entry under the " Appendices 
" heading on the Table of Contents page, like the subheadings. 

 

Is the CV prepared following the guidelines? 
 
A curriculum vitae (CV) should be attached at the end of theses and projects. The CV 
is a short biographical sketch of the author, including contact and educational 
information, publications, teaching, and professional experience. It should be written 
in the third person and added to the Table of Contents as the last item. 

 

Is the thesis to be printed for the final thesis submission set to be printed 

on one side of the paper?  
 
Theses should not be printed front and back. 

 

• In your thesis file, all the points you need to apply according to the guidelines are listed in 

the summary, and make sure that you have used all these items before finalizing your thesis. 

 


